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The Model 900 Viscometer is a portable, yet fully automated system for

measuring fluid viscosity.  It is designed to be easy to use, easy to maintain

and to provide consistent results.  Its simplicity makes it ideally suited for

field applications.  Engineers will appreciate the push button calibration, its

reliability, and the ability to perform standard American Petroleum Institute

(API) recommended practices with one command.  With the addition of a

computer, it is able to perform a variety of more complex laboratory tests.

Routine repairs, like bearing and torsion spring replacement, may be per-

formed by field personnel with a minimum of training, without having to

return the viscometer for repair.

The OFITE Model 900 Viscometer is a true Couette coaxial cylinder rota-

tional viscometer, which employs a transducer to measure the induced

angle of rotation of the bob by a fluid sample.  The test fluid is contained in

the annular space, or shear gap, between the rotor and the bob, which is

attached to a shaft with a biasing spring.  The viscous drag exerted by the

fluid creates a torque on the bob, and is monitored by the transducer that

measures the angular displacement of the bob.  Using the angle of dis-

placement of the bob, the processor calculates and transmits readable out-

put of the sample characteristics in accordance with determined calcula-

tions based upon the shear rate and the bob displacement.  Revolutionary

improvements in stepper-motor technology by OFITE enables the Model

900 Viscometer to operate accurately at extremely low shear rates (0.01

1/s). 

As a stand-alone field unit, the press of a single button (MUD or CEM)

prompts the viscometer to perform standard API recommended practices

for the technician’s choice of Mud (Plastic Viscosity [“PV”] - Yield Point

[“YP”]) or Cement rheologies.  Standard speeds (600, 300, 200, etc.) are

provided as single button operations on the keypad, or if another shear rate

is desired, the parameters may be entered on the numbered keypad.

Simply press ENTER after entering the desired shear rate and the vis-

cometer performs the rest of the work.  It is not necessary to stop the

motor between speed changes.

For a fully automated Control/Data Acquisition System suitable for research

applications, the Model 900 Viscometer may be connected to a computer

via a serial (RS-232) port using OFITE's exclusive and field-proven

Windows™-based ORCADA™ software.

Description

Intro



Components #130-76-03 Thermocouple

#130-76-04 Main Bearing; Qty: 2

#130-76-05 Retaining Ring

#130-76-06 Drive Belt

#130-76-07 Drive Gear

#130-76-09 1.5 mm Allen Key

#130-76-10 Universal Heat Cup (115-Volt Only)

#130-76-10-1 Universal Heat Cup (230-Volt Only)

#130-76-11 Terminal; Qty: 8

#130-76-12 Header; Package of 19

#130-76-14 Standoff; Qty: 4

#130-76-15 Nylon Washer; Qty: 4

#130-76-16 Nylon Washer; Qty: 4

#130-76-17 Nylon Washer; 5⁄8" ID

#130-76-23 Gear

#130-76-24 Bob Shaft Assembly

#130-76-28 Motor

#130-76-34 Splash Guard

#130-76-35 Keypad

#130-76-36 Motor Spacer; 1⁄8"; Neoprene; 70 Durometer

#130-76-37 Transducer

#130-76-38 Control Card

#130-76-40 Back Panel

#130-76-41 Cover

#130-76-42 Display

#130-76-43 SSR

#130-76-44 Thermocouple Jack

#130-76-45 Sensor Plate

#130-76-46 Display Cable

#130-76-48 Power Supply

#130-76-51 Carrying Case

#130-79-15 Serial Cable; OB9; M/F

#132-56 Rotor, R1, 303 Stainless Steel

#132-58 B1 Bob; 303 Stainless Steel

#132-80 Certified Calibration Fluid; 100 cP; 10 oz

#134-05-2 Bob Shaft Bearing; Sealed

#134-10 Torsion Spring Assembly; F1.0

#135-02 External Retainer Ring for Bob Shaft; Qty: 2

#135-19 Socket Set Screw; Nylon Tip for Spring Bushing; Qty: 2

#135-19 Socket Set Screw; Nylon Tip for Spring Bushing; Qty: 3

#135-19-1 Socket Set Screw; 8-32 × 3/16; Nylon Tip; Qty: 2

#142-63 Locking Screw

#152-37 AC Power Cord; 3-Conductor (115-Volt Only)

#152-38 AC Power Cord; 3-Conductor; International (230-Volt Only)

#171-44 Rubber Foot; 3⁄4"; Qty: 4
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Optional:

#130-76-P pH Meter

#132-58-1 B2 Bob; 303 Stainless Steel

#132-58-2 B3 Bob; 303 Stainless Steel

#132-58-3 B4 Bob; 303 Stainless Steel

#132-58-4 B5 Bob; 303 Stainless Steel

#132-58H B1 Bob; Hastelloy

#134-10-2 Torsion Spring Assembly; F0.2

#134-10-3 Torsion Spring Assembly; F0.5

#134-10-4 Torsion Spring Assembly; F2.0

#134-10-5 Torsion Spring Assembly; F3.0

#134-10-6 Torsion Spring Assembly; F4.0

#154-04 Digital, Long-Stem Thermometer; NIST Traceable; 8" Stem; -

58°F - 302°F (-50°C - 150°C)

#154-24 Thermometer; 32°F - 86°F (0°C - 30°C)

#130-76-C-SP Spare Parts for #130-76-C

#130-76-1-C-SP Spare Parts for #130-76-1-C

#130-76-03 Thermocouple

#130-76-04 Main Bearing; Qty: 4

#130-76-05 Retaining Ring; Qty: 2

#132-80 Calibration Fluid; 100 cP; 16 oz.; Qty: 2

#132-81 Calibration Fluid; 50 cP; 16 oz.

#134-05-2 Bob Shaft Bearing; Qty: 6

#134-10 Torsion Spring Assembly F 1.0

#135-02 External Retainer Ring; Qty: 2
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Specifications
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Range of Measurement for Model 900

Rotor - Bob R1B1 R1B2 R1B3 R1B4

Rotor Radius, RR, (cm) 1.8415 1.8415 1.8415 1.8415

Bob Radius, RB, (cm) 1.7245 1.2276 0.8622 0.8622 

Bob Height, L, (cm) 3.8 3.8 3.8 1.9

Shear Gap, (cm) 0.117 0.6139 0.9793 0.9793 

R Ratio, RB/RR 0.9365 0.666 0.468 0.468 

Instrument Geometry True Couette Coaxial Cylinder

Motor Technology Stepper

Motor Speeds (RPM)

12 Fixed Speeds (600, 300, 200, 100, 60,

30, 20, 10, 6, 3, 2, and 1); Variable speed

range .006 - 1000

Speed Accuracy (RPM) .001

Shear Rate Range (sec-1) .01 - 1,700

Readout Digital

Heat Cup
Stainless Steel, 150 Watts, Maximum

Recommended Temp: 190°F (88°C)

Temperature Measurement Type “J” Thermocouple

Automatic Tests API Cementing and Mud Rheologies

Power Requirements 97 - 250 Volts AC, 200 Watts, 50/60 Hz

Weight (kg) 8.6

Dimensions (cm) 44 × 38 × 24

Shipping Weight (kg) 16

Shipping Dimensions (cm) 56 × 38 × 24

Computer Requirements

DB-9 Serial Port, Windows 2000 or XP.

Recommended screen resolution 1024 ×

768 pixels.

Max. Shear Stress, SSMAX,

(Dyne / cm2) 
R1B1 R1B2 R1B3 R1B4

F 0.2 330 651 1320 2644

F 0.5 840 1657 3359 6730

F 1.0 1680 3314 6717 13460

F 2.0 3360 6629 13435 26921

F 3.0 5040 9943 20152 40381

F 4.0 6720 13257 26870 53841

F 5.0 8400 16571 33587 67302

F 10.0 16800 33143 67175 134603
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Shear Rate Range R1B1 R1B2 R1B3 R1B4

Shear Rate Constant, KR, 

(sec-1 per RPM)
1.7023 0.3770 0.2682 0.2682

Shear Rate, (sec-1 or 1/s)

1 RPM
1.70 0.38 0.27 0.27

2 RPM 3.40 0.75 0.54 0.54

3 RPM 5.11 1.13 0.80 0.80

6 RPM 10.21 2.26 1.61 1.61

10 RPM 17.02 3.77 2.68 2.68

20 RPM 34.05 7.54 5.36 5.36

30 RPM 51.07 11.31 8.05 8.05

60 RPM 102.14 22.62 16.09 16.09

100 RPM 170.23 37.70 26.82 26.82

200 RPM 340.46 75.40 53.64 53.64

300 RPM 510.69 113.10 80.46 80.46

600 RPM 1021.38 226.20 160.92 160.92

1,000 RPM 1702.30 377.00 268.20 268.20

Viscosity Ranges<a>

(cP)
R1B1 R1B2 R1B3 R1B4

Minimum Viscosity<b>

@600 RPM
0.5<c> 4.5 12.7 25

Maximum Viscosity<d>

@0.01 RPM
10,000,000 89,000,000 255,000,000 500,000,000

<a> Computed for standard Torsion Spring (F 1.0).  For other torsion springs, multiply by F factor

<b> Lower viscosities can be measured by the Model 900, however one must take into account the

effect of bearing drag, Taylor vortices, zero offset, etc. when looking at the expected accuracy of

the reading

<c> For practical purposes the minimum viscosity is limited to 0.5 cP due to Taylor Vortices

<d> Maximum viscosity is based on Maximum Shear Stress and Minimum shear rate (RPM).  However,

due to practical and physical limitations, it may be difficult to take these measurements.

Viscosity Conversions

To convert from units on left side to units on top, multiply by factor @ intercept.

Centipoise

(cP)
Poise (P) g/(cm*s) (mN*s)m2 mPa*s

(lb*s)

100 ft2

Centipoise

(cP)
1 0.01 0.01 1 1 0.002088

Poise (P) 100 1 1 100 100 0.2088

g/(cm*s) 100 1 1 100 100 0.2088

(mN*s)m2 1 0.01 0.01 1 1 0.002088

mPa*s 1 0.01 0.01 1 1 0.002088

(lb*s)

100 ft2
478.93 4.789 4.789 478.93 478.93 1
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What Bob & Spring Should I Use?

There is often confusion or misunderstanding about what a viscometer can

actually measure.  For example, a viscometer with a R1B1 F1 combination

can measure water fairly well at 100 RPM and higher, but at 3 RPM, the

readings would be shaky at best. While on the other hand, a linear fluid

with a viscosity of 15000, could not get past 6 RPM with the same combi-

nation.

To estimate which spring might be best, use the formula below to calculate

a Minimum Spring factor, where one establishes the maximum RPM the

fluid is going to be tested at, as well as what the expected “Apparent

Viscosity” of the fluid would be at that RPM.  If the Factor comes out as

.87, then a F 1.0 spring should be used.  If it comes out as .16, then a F

0.2 spring would be best.  To cover all ranges, it may be necessary to use

more than one spring.

Minimum Spring Factor (F) = RPM(max) * AV(max)

BOB(F)*90000

Shear Stress Conversions

To convert from units on left side to units on top, multiply by factor @ intercept.

Dyne/cm2 Pa lb/100ft2 lb/ft2 DR

Dyne/cm2 1 0.1 0.2084 0.002084 0.1957

Pa 10 1 2.084 0.02084 1.957

lb/100ft2 4.788 0.4788 1 0.01 0.939

lb/ft2 478.8 47.88 100 1 93.9

DR 5.107 0.5107 1.065 0.01065 1

Bob (F)

R1B1 1.0

R1B2 8.9

R1B3 25.4

R1B4 50.7



Safety In order to comply with the requirements of safety standard EN 61010, the

viscometer has a separable cord and plug, without a locking device, to

mate with a socket outlet in the building.  If the user substitutes another

cord, the cord should not exceed 3 meters (9'10") in length.

Any interruption of the protective earth conductor inside or outside the

instrument, or disconnection of the protective earth terminal is likely to

make the instrument dangerous under some fault conditions.  Intentional

interruption is prohibited.

If the equipment is used in a manner not specified by the manufacturer, the

protection provided by the equipment might be impaired.  Whenever it is

likely that protection has been impaired, the instrument should be made

inoperative, and secured against accidental operation.  OFITE Technical

Service should be contacted for advice.

Any service performed by removing the viscometer cover should only be

performed by a knowledgeable operator.

There are no user-serviceable components inside the heat cup cover. The

Heat Cup should only be serviced by a factory-authorized technician.
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1. Connect the instrument to a power source.  This viscometer will operate

equally well at 115 Volts or 230 Volts, 50 or 60 Hz. 

Always plug the Model 900 into a surge suppressor instead of

directly into an electrical outlet.  The internal electrical compo-

nents can be damaged by voltage spikes.

2. To control the temperature, plug the thermocouple into the left side of

the housing cover and place the thermocouple into the thermocouple

well of the thermocup.  Also plug the power cord of the thermocup into

the back of the Model 900. 

3. With the instrument turned OFF, place the splash guard onto the bob

shaft with the short tube end up towards the bearings.

The Model 900 must be turned off each time the bob is installed or

removed.

4. Screw on the appropriate bob with tapered end up towards splash

guard.

5. Using the bobshaft wrench provided, locate the wrench flats on the

shaft and place the wrench here for tightening the bob in place.  

Do not tighten against the “stop pin” of the instrument!

6. Position the rotor over the bob and move it upwards to join the rotor.

The threads assure the rotor will attach evenly and uniformly each and

every time.
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Setup

�
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!
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!

�
Important

!

Bob

Drive Rotor

R1 Rotor

Bob Shaft Wrench Splash Guard



7. The On-Off switch is located on the back panel, just above the power

cable connection. Turn the unit ON and follow the display instructions,

or press CLEAR/STOP.

8. Refer to the “Thermocouple Calibration” section on page 45.

It is recommended that a calibration procedure be run due to the

possibility of mishandling during shipment of the Model 900.

Refer to the “Calibration - Standalone” section on page 20 for

instructions on calibrating the unit manually.  Refer to the

“Calibration - With Computer” section on page 24 for instructions

on calibrating the unit with the ORCADA™ Software.

9. Place a properly prepared sample of test fluid (if an R1B1 bob is being

used, approximately 165 - 170 mL) in the sample cup and immerse the

rotor exactly to the scribed line on the rotor by raising the platform.

Tighten the lock nut on the platform.

10. If you are using the optional pH Meter, refer to the “pH Meter for

Model 900” instruction manual for detailed information about setting up

and using the pH Meter with the Model 900.

When operating under computer control, the keypad on the Model 900

unit is disabled and the unit is controlled from the PC.  However, the

type of bob being used for the test must be entered in SETUP (refer to

step 5 on page 20 for details) before connecting the unit to the PC.
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The OFITE Model 900 Viscometer can be operated from a PC using the

ORCADA™ 5.75 Model 900 software.  When operating under computer

control, the keypad on the Model 900 is disabled and all operation is con-

trolled from the PC.

The computer must be equipped with a DB-9 serial port. If your computer

does not have a DB-9 serial port, it is recommended that you purchase a

USB to Serial adapter by a third party vendor. 

The computer must be running Windows® 2000 or Windows® XP.  For opti-

mum viewing, it is recommended that your computer’s display be set to

1024 x 768 pixel resolution.

1. Double-click the “ORCADA” icon on the desktop.

2. The first time you run the software, you will be asked to select a hard-

ware configuration.  Select the the appropriate device and click “OK”.

You will now see the Main Screen.

3. The Windows XP firewall may try to block the ORCADA software from

communicating with the viscometer.  If the firewall shows the following

alert, select “Unblock”.

Software Start

Available Tests

Manual Mode 

Controls
Analysis Data Process Variables

StatusLog Indicator
Communication

Indicator

Key

Main Screen

Windows XP Firewall Alert
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“Start Test” - This button starts a test in Auto Mode.  Once a test is start-

ed, this button becomes the “Abort Test” button.  Click here to stop the test.

“Cement” - This button performs the same function as the “CEM” button

on the unit’s keypad.  Refer to page 22 for more information.

“Mud” - This button performs the same function as the “MUD” button on

the unit’s keypad.  Refer to page 21 for more information.

The “Mud” and “Cement” buttons perform standard tests based on API

specifications.  These tests ignore the “Dead Time” and “DAQ Time” set-

tings on the Options screen.  Temperature control, which is disabled during

custom Auto-Mode tests, is available during a “Mud” or “Cement” test.

“Progress” - This button opens the Test Progress window, which shows all

of the steps of the current test and highlights the one currently in process.

“Status” - This box at the top of the screen shows the current status of the

test.

“Comm Timeout” - This light will be off when the PC is successfully com-

municating with the viscometer.  If communication is interrupted for any

reason, the light will shine red to indicate a problem.

“Start Logging” - This button is available in manual mode only.  Click here

to begin recording test data.  The light next to this button will shine green

while logging is in progress.  

�
Note



“Cond Pause” - This button will pause a test during the conditioning phase

and put the software into Manual Mode.  While the test is paused, the

motor and heat controls can be controlled in the same manner as in a stan-

dard Manual Mode test.

To resume the test, click the “Cond Pause” button again.  You will be asked

if you want to “Continue” the test with the remaining conditioning time or if

you want to “Override” the remaining time and extend the effective condi-

tioning time.  If you choose to “Continue”, the time remaining in the condi-

tioning cycle will appear as though the test was never paused.  If you

choose to “Override”, the time remaining in the conditioning cycle will

resume at the point where the test was paused.

For example, assume a test has a conditioning time of 10 minutes and the

test is paused at the 5 minute mark for 1 minute.  If the test is unpaused

using the “Continue” option, the time remaining in the conditioning cycle will

be 4 minutes.  However, if the test is unpaused using the “Override” option,

the time remaining in the conditioning cycle will be five minutes, making the

effective total conditioning time 11 minutes.

“Raw File Save Period” - This field determines how often data is recorded

during a test.

“Experiment Name” - This field will be used to identify the experiment

later.  This field is required before starting a test in Auto Mode or starting

logging in Manual Mode.  

“Bob” - Select the type of bob currently being used in the unit.  An incor-

rect value in this field will adversely affect your test results.

“Key” - The checkboxes next to the graph key enable and disable graph-

ing of the indicated values.  For example, to exclude RPM from the graph,

uncheck the “RPM” box.  You can also customize the appearance of the

lines on the graph by clicking on the line example on the right side of the

key.

“Manual Mode Controls” - The manual mode controls, in the bottom left-

hand corner or the screen, adjust the rotor speed and the temperature

while the unit is operating in manual mode.  

“Rotation” - This field determines the rotational speed.  The drop-down

box beneath the field sets the units to either RPM or 1/s.
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“Enable” - Place a check in this box to engage the motor.  Uncheck

the box to stop the motor.

“Temp” - This field determines the test temperature.  The drop-down

list beneath the field sets the units to either °F or °C.

“Enable” - Place a check in this box to enable temperature control.  If

the value in the “Temp” field is higher than the sample temperature, the

heaters will engage to heat the sample.

“PreHeat” - This field is not used on the Model 900.

“Cool” - This field is not used on the Model 900.

“Clear” - This button removes all data from the graph.

“Analysis Model” - This field, below the graph, displays the current

Analysis Model being used in the test.  This variable is set in the Test

Builder (refer to page 28 for more information).

“Analysis Data” - This chart shows the calculated values based on the

Analysis Model being used for the test.  This data will not display until after

the analysis sweep is completed.

“Temperature”, “Shear Stress”, “Viscosity”, “Shear Rate”,  “RPM” -

These fields display the current value for these variables.  They are display

only.  The drop-down box next to the “Shear Stress” field changes the units

of the Shear Stress variable.  The units can be set to: Dyne/cm2, lb/100ft2,

Pa., Dial Reading, lb/ft2
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The calibration procedure is easily performed by pressing the CAL button

and following the instructions as you are prompted on the unit’s display

screen.  Calibrations should be routinely performed prior to rheological test-

ing and are necessary after changing out bearings or the torsion spring.    

For the most accurate calibration results, calibrate the thermocouple before

performing the following procedure.  Refer to page 45 for instructions.

If you use a computer with the Model 900, you must unplug the connection

before beginning the procedure.

1. “Check P is 15,000 - 25,000.  Adjust then Enter.  P=XXXXX”

A number for “P” (Position of the Transducer) will be initially displayed

on the screen.  If this number falls outside the given range, the torsion

spring will need to be manually adjusted so the “P” falls within the

parameters.

a. Remove the stainless housing cover.

b. Loosen the two 5/64" allen set screws on the side of the torsion

spring housing (see picture on page 44).  

c. Position the housing-cover so the display can be read, and gradual-

ly rotate the Zero Calibration Knob in very small increments until the

number displayed falls within the given range for “P”.  

d. Carefully lower the housing straight down onto the unit chassis.

e. Re-tighten set screws.

Press ENTER.

2. “Max vis. for 300 RPM is 300.0 cP”
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Calibration
Standalone

�
Note

Recommended Viscosities for 
Calibration at 300 RPMs 

for various Torsion Springs (R1, B1):

Torsion Spring, F0.2  =  60 cP

Torsion Spring, F0.5  =  150 cP

Torsion Spring, F1.0  =  300 cP

Torsion Spring, F2.0  =  600 cP

Torsion Spring, F3.0  =  900 cP



3. Add approximately 170 mL calibration fluid into the clean and dry stain-

less steel sample cup.  Place the sample cup with calibration fluid onto

the platform.  Loosen the lock nut on the platform with the stainless

steel arm until the fluid level reaches the scribed line on the rotor.

Tighten the lock nut on the platform.

4. Allow a couple of minutes for the temperature of the calibration fluid to

equalize.

5. Find the calibration sheet attached to the calibration fluid you are using.

Record the viscosity at the temperature being read on the unit.

6. Enter the actual viscosity (listed on the calibration sheet) of the calibra-

tion fluid (must be <= 300 cP if the standard B1 Bob, R1 Rotor and F1

Torsion Spring are used) using the left side of the keypad.  Press

ENTER.

7. The machine will perform the calibration internally in a series of

sweeps, and return to the main screen.

8. Turn the unit OFF.

9. Loosen the lock nut on the platform while holding the bottom of the plat-

form with your other hand.  Slowly lower the platform with the sample

cup and calibration fluid.  Allow the stainless steel cup to remain

beneath the bob and rotor to allow residual calibration fluid to drain.

10. Pour the calibration fluid from the sample cup back into the 16 oz. (500

mL) container.

Used calibration fluid can contaminate new fluid.  Before mixing

the used with the new, inspect the used fluid for contamination.

Discard any fluid that is cloudy or contains suspended solids.

11. Remove the rotor.  Wipe any residual calibration fluid off the rotor and

the bob with either a paper towel or a soft cloth.  Make sure the wrench

is in place prior to wiping off the bob.  Wipe the sample cup dry with a

paper towel.
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Before the Model 900 unit can be calibrated using the ORCADA™

Software, the Calibration Mode must be set to “ORCADA Software”.  Refer

to the “Software - Options” section on page 26 for more information.

From the main screen choose, “Calibrate Shear Stress” from the “Utilities”

menu. 

1. Select a calibration fluid from the “Cal Fluid Batch” drop-down list.

If the list is empty, click the “Fluid Manager” button to add new fluid

batches.  Refer to page 19 for more information.

If the “Temp Out of Range” light shines red, the current sample tem-

perature is out of the specified range for the calibration fluid.  The

sample will have to be heated or cooled to be within the acceptable

range before calibration.

Do not attempt a calibration if the sample is not within the

appropriate temperature range.

2. Choose a set of calibration rates from the “Rate Set” drop-down list.

To create or edit a rate set, click the “Calibration

Rates” button.  To create a new set, click the “New”

button and enter a name and the rotational speeds.

To edit a set, select it in the “Rate Set” list, then

change the rotational speeds as necessary.

3. Click the “Start Calibration” button to begin the cali-

bration.

Once the calibration has started, the software will begin filling in the

chart and plotting the results on the graph.
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Calibration
With Computer

Rate Sets



4. As the calibration proceeds, the software will begin to display the

collected data in the chart.  At the end of the calibration, the soft-

ware will calculate the “r^2” value, which measures the accuracy of

the calibration.  If this value is less than 0.9990, recalibrate the unit.

If this value is still low, change the lower bearing (see page 40 for

instructions) and try the calibration again.  If the unit still does not

calibrate, it will require servicing by an OFITE technician.

“S.S. Reference” - the ideal shear stress as calculated by the software

“S.S. Raw” - the actual signal coming from the unit

“RPM” - rotational speed

“Viscosity Reference” - the ideal viscosity of the sample as calculated

by the software

“Temp” - the temperature of the sample at the time viscosity was meas-

ured

“S.S. Best Fit” - shear stress value demonstrated by the viscometer

“Viscosity Best Fit” - viscosity value demonstrated by the viscometer

“S.S. Fit Error” - deviation of actual shear stress from “S.S. Best Fit”

“r^2” - This is a measure of the accuracy of the calibration.  It will be

calculated at the end of the calibration cycle.  If this value does not

read greater than 0.9990 after multiple calibration tests, the unit will

require servicing or new bearings.

“r^2C” - This value is not used on the Model 900 and should be

ignored.

“Temperature” - the temperature of the sample

“Shear Rate” - rotational speed (1/s)

“RPM” - rotational speed (RPM)

“Shear Stress Raw” - the actual signal coming from the unit

“Ref Viscosity” - the ideal viscosity of the sample as calculated by the

software

“Ref Shear Stress” - the ideal shear stress as calculated by the soft-

ware
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Calibration
Fluid Manager

Before calibrating the unit, you must input the specifications of the calibra-

tion fluid that you are using.  This will give the software the information it

needs to perform the calibration accurately.

Click the “Fluid Manager” button on the Calibration screen to add a new

calibration fluid batch.

1. Click “New” to add a new batch.  You can also edit an existing batch

by selecting it in the “Batch Selector” list.

2. In the “Batch” field, type a name for the batch.  OFITE recommends

using the lot number and viscosity from the Certification Chart that

was provided with the fluid.

3. In the “Calibration Fluid Table”, enter at least two

Temperature/Viscosity pairs from the Certification Chart.  Only two

pairs are required.

The “Table Linearity Error” light will shine red if the values in the

“Calibration Fluid Table” do not create a straight line.  If this occurs,

check the values and re-enter them.

4. Once you have entered all the batches, click “OK” to close the Fluid

Manager and return to the Calibration screen.



When operating in stand-alone mode, the keypunch panel on the top of the

viscometer is used.  Following are descriptions of the buttons:

1. Individually numbered buttons on left side - 0 (zero) through 9 (nine)

Used to set RPMs or 1/s.  Accurate to two decimal places (0.01 RPM).

After entering the desired shear rate, follow by pressing the ENTER

key. 

2. Numbered buttons on right side - 600, 300, 200, 100, 60, 30, 20, 10,

6, 3, 2 and 1

These are shear rates typically used in oilfield rheology, and provide a

quick and convenient means of changing the rotor speeds.  The RPM

speed may be quickly and directly changed by pressing the numbered

pads.  No programming or any other entry is necessary. 

3. CLEAR / STOP

Used to end a test sequence, or to re-enter. 

4. NEXT

Used for sequencing functions.

5. SET UP

Used to program the machine.  The unit prompts you to enter a value

for each parameter, or you can simply press NEXT to accept the

defaults.  Descriptions of the parameters in the order they appear on

the display follow below:

a. “Temperature”:

“Current”: Set point target temperature for machine to ramp to.

“New”: New target temperature. 

Press ENTER and then NEXT.

b. “Bob #”: 1 is standard

“New (1 - 5)”: Use if another bob (B1, B2, B3, etc.) is used.

Press ENTER and then NEXT.

c. “SS Units”: Changes the shear stress measuring units that are

displayed.  Enter selection number or leave alone if unchanged.

1 = Dynes/cm2 2 = Pa (Pascal) 5 = lb/ft2

3 = lb/100ft2 4 = D.R. (*Dial Reading)

Press ENTER and then NEXT.
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Operation
Standalone

*Used to calculate an association with a mechanical viscometer.



d. “Shear Rate Units”:  Changes the shear rate units.  Enter selec-

tion number or leave alone if unchanged.

1 = RPM 2 = 1/s (Reciprocal seconds)

Press ENTER and then NEXT.

e. “Spring #”: Changes the Torsion Spring Assembly, F0.2, F0.5, F1.0,

F2.0, etc.  A spring number will be displayed.

“New”: Enter selection number or leave alone if unchanged.

Press ENTER and then NEXT.

f. “Temperature Units”: Either “C” or “F” will be displayed

“New”: To change temperature scale from existing one.

Enter selection number or leave alone if unchanged.

1 = C (Celsius) 2 = F (Fahrenheit)

Press ENTER and then NEXT.

g. “Temp. Control”: Determines how the temperature is to be con-

trolled.  Either “0” or “1” will be displayed.

“New”: To change from existing mode.

0 = Auto - Temperature controlled from Viscometer 

1 = Manual - Temperature controlled by Heat Cup Knob

Press ENTER and then NEXT.  This will take you back to the

beginning.

Press CLEAR/ STOP.

h. “Temperature Offset”: Refer to the “Thermocouple Calibration”

section on page 45.

6.  CAL

Provides a quick and easy method of internally calibrating the viscome-

ter.  Refer to the “Calibration - Standalone” section on page 20 for more

details.

7. MUD

By pressing this button once, the viscometer will automatically meas-

ure, calculate and display Plastic Viscosity (“PV”), cP, and Yield Point

(“YP”) in dial readings, as per API recommended practice 13B1, 13B2,

and 13D.  This enables the technician to simultaneously perform other

tasks, and it assures increased accuracy and reproducibility, as each

test is conducted in the same manner and for the same time periods.
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a. Press MUD.  The following steps will be performed.  At each inter-

val, the viscometer stabilizes and then records a reading.  If you

prefer not to wait for the 10 minute Gel test, you may hit NEXT to

cancel that particular operation, while still obtaining readings on

everything else that was measured.

1) Mixing Speed 

2) 600 RPM for 15 seconds

3) 600 RPM for 10 seconds

4) 10 second Gel (Wait 10 seconds)

5) Mix for 10 seconds

6) 10 minute Gel (Wait 10 minutes)

b. After the completion of the test, the following is displayed:

1) “PV” =

2) “YP” =

3) “10 Sec Gel” =

4) “10 Min Gel” =

8.  CEM

By pressing this button once, the viscometer will automatically meas-

ure, calculate and display shear stress dial readings as per API

Recommended practice 10.  This automation enables the technician to

simultaneously perform other tasks.  It also assures increased accuracy

and reproducibility, as each test is conducted in the same manner and

for the same time periods.    

a. Press CEM.  The viscometer will automatically begin ramping up to

300 RPM and back down, taking readings at specific intervals along

the way.  At each interval, the viscometer maintains the RPM speed

for 10 seconds for stabilization and then records a reading.  If you

prefer not to wait for the 10 minute Gel test, you may hit NEXT to

cancel that particular operation, while still obtaining readings on

everything else that was measured.  The RPM intervals at which

data is gathered include:

1) 3 RPM

2) 6 RPM

3) 30 RPM

4) 60 RPM 

5) 100 RPM

6) 200 RPM

7) 300 RPM

8) 200 RPM

9) 100 RPM

10) 60 RPM

11) 30 RPM
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12) 6 RPM

13) 3 RPM

14) 10 second Gel (Wait 10 seconds)

15) 10 minute Gel (Wait 10 minutes)

b. After the completion of the test, results are displayed as follows.

Clicking NEXT allows you to proceed to the next set of readings.

1) “Up Readings” for all the test speeds

2) “Down Readings” for all the test speeds

3) “Avg Readings” for all the test speeds

4) “Gels & Temp”

1. 10 Sec =

2. 10 Min =

3. Temp = 

9. In addition to the pre-installed programs (MUD and CEM), the OFITE

Model 900 contains 8 slots for custom programs created with the

ORCADA™ Software.  Refer to page 36 for instructions on creating

custom programs.  To access these custom programs:

a. Press the SET UP key twice.

At this point you can press the ENTER key to recall the results of

the last test run.

b. Press the SET UP key again to select a new test to run.

c. Select a test by pressing the numeric key corresponding to the test

you wish to run.  The test will start immediately.

d. When the test is complete, the unit will beep.  

e. Press the NEXT key to page through the test results.

f. Press the CLEAR/STOP key to return to the main menu.
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The ORCADA™ software has two modes for running tests: Auto and

Manual.  By default, the software is in Manual mode when first opened.

To begin a test in Manual mode:

1. Add approximately 170 mL of test fluid to the clean and dry stain-

less steel sample cup.

2. Enter the raw file save period (in MM:SS, where MM is the two digit

number of minutest and SS is the two digit number of seconds) and

select the shear stress units from the drop-down menu.

3. Enter a temperature in the “Temp” field and choose Celsius or

Fahrenheit.

4. Select the “Enable” checkbox next to the “Rotation” field to start the

motor.  

Once the motor is started, the display fields on the right-hand

side of the screen will begin displaying test data.

5. Select the “Enable” checkbox next to the “Temp” field to start the

heater.

The “Preheat” and “Cool” options are used for pressurized vis-

cometers only.

6. Enter a name in the “Experiment Name” field and click the “Start

Logging” button.

7. Enter a comment in the resulting dialog box.  Comments are option-

al, but can be used later to identify the test results.

To begin a test in Auto mode:
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1. Add approximately 170 mL of test fluid to the clean and dry stain-

less steel sample cup.

2. Enter the raw file save period (in MM:SS) and select the shear

stress units from the drop-down menu.

3. Highlight a test to run from the list in the upper left-hand corner of

the Main Screen.  Refer to page 28 for instructions on creating cus-

tom tests.

4. Enter a name in the “Experiment Name” field.

5. Click the “Start Test” button.

6. Enter a comment in the resulting dialog box.  Comments are option-

al, but can be used later to identify the test results.

Caution:  The Model 900 Viscometer thermocouple must be immersed

in the fluid before enabling the temperature or heating a sample in the

heat cup.
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To access the Options screen, choose “Options” from the “Edit” menu.

“900 Calibration Mode” - Place the slider on “ORCADA Software” to

enable the calibration screen.  Place the slider on “Onboard” to calibrate

the unit using the onboard controls.

“Spring Constant” - Enter the type of spring being used in the unit.

“Scientific Instruments pH Com Port” - This field specifies which Com

port the external pH Meter is connected to.

“Enable pH” - Check this box if you are using an external pH Meter.  This

will enable the “pH” and “Temp pH” fields in the process variable area of

the Main Screen.  It will also make “pH” an option on the key to the graph.

“RPM DAQ Settings” - “RPM High”, “RPM Med” and “RPM Low”, “Dead

Time”, “DAQ Time”.  These fields are used to determine the amount of time

needed for the sample to stabilize at a given rate.  The fields are also used

to determine the amount of time data is averaged before being saved.  For

example, if RPM High is set to 60, Dead Time is set to 15 and DAQ Time is

set to 20, any rate of 60 RPM or greater during a sweep would stabilize for

15 seconds then begin averaging data for 20 seconds before saving the

data. 

“Com Port” - This field specifies which Com port the viscometer is con-

nected to.

“DAQmx Device Name” - If multiple DAQ cards are installed on the PC,

choose the card you wish the unit to use.

“Slave ID” - If multiple units are being monitored through the ORCADA™

Software, each one must be identified by a unique “Slave ID”.

“Reverse Rates Gel UI” - If “Hystoresis” is selected on the “Test Builder”

screen (see page 28), this option will perform a gel test after both the for-

ward and backward portions of the sweep.

“Data Archive Directory” - This field specifies the directory to store

archived data.

Software
Options
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By default, the ORCADA™ Software saves data to file based on a set time

interval.  This time interval can be changed by editing the “Raw File Save

Period” field on the main screen.  However, the “Save Rate Settings” fea-

ture provides more control over data save points.  The software will monitor

each selected variable and record a data point to the file when that variable

changes by the amount specified. 

1. Select “Save Rate Settings” from the “Edit” menu. 

2. Place a check mark next to each variable you wish to monitor.

3. In the field after the variable name, enter the variance required to initi-

ate a save point.

For example, if you want the software to record a data point when the

temperature increases or decreases more than 5°, place a check next

to “Temperature” and enter 5 in the field next to it.

4. Click “OK” to save the settings and return to the main screen.

“Elapsed Time” - seconds since the start of the test

“RPM” - rotational speed (RPM)

“Shear Rate” - rotational speed (1/s)

“RPM SP” - rotational speed setpoint

“Temperature” - measured sample temperature

“Temperature pH” - temperature reading from the external pH meter

“Temp SP” - temperature setpoint

“Temp Duty Cycle” - the frequency (in seconds) the

heaters engage to increase the temperature

“Viscosity” - measured viscosity (cP)

“Shear Stress” - measured shear stress

“Shear Stress Tare” - change in measured shear stress

“pH” - pH reading from the external pH meter

Software
Save Rate Settings
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Software
Test Builder

The Test Builder is designed to help you build custom tests for use in Auto

mode.  To access the test builder, go to the Main Screen and choose “Test

Builder” from the “Edit” menu. 

1. To create a new test, click the “New Test” button.  To create a new

test based on one of the “RP 10B”, “RP 13D”, or “RP 39” analysis

models, click the appropriate button at the top of the screen to open

a template.  To edit an existing test, select the test from the list in

the upper left-hand corner of the screen. 

2. Enter a name in the “Test Name” field.

3. Choose an Analysis Model.

a. “RP 39” - Power Law Model - records the Power Law calcula-

tions (n and k)

b. “RP 13D” - Bingham Plastic Analysis Models - records plastic

viscosity (PV) and yield point (YP)

c. “RP 10B” - Power Law and Bingham Plastic Models combined

4. Input the values for your test into the fields in Record 1.

a. “Heat Time” - the time it will take the unit to heat the sample to

the temperature setpoint.  If this field is left blank, the unit will

heat the sample as fast as possible.

b. “Heat RPM” - the rotational speed during the heating period

c. “Temp” - the temperature setpoint.  Enter any letter in this field

to indicate “Ambient”.

RecordsAvailable Tests

Test Detail



d. “Cond. Time” - the time period to condition the sample

e. “Cond. RPM” - the rotational speed during conditioning

f. “#/Swps” - the number of sweeps to perform after conditioning.

A sweep is a set of rotational speeds separated by time interval.

Between sweeps, the rotor returns to the Cond. RPM.  At the

end of each sweep, the unit calculates the Analysis Model val-

ues.

g. “Delta Time” - the time interval between sweeps

h. “Gel Time 1” - During a gel time interval, the rotor comes to a

complete stop and waits.  At the end of the interval, the rotation-

al speed is increased to 3 RPM until the gel breaks and a gel

strength value is recorded.  Click the “Insert Gel Column” button

to add a gel time to the record. 

i. “RPM 1, 2, 3, etc.” - The RPM fields set the speed of each step

of the sweep.

5. Repeat step 4 in the following record fields until you have complet-

ed building your test.

6. Click the “OK” button to save the test and return to the main screen.

“Hold for Temp” - Click this checkbox to tell the unit to wait until the sam-

ple has reached the temperature setpoint before proceeding to the next

step.  If this box is unchecked, the test will proceed while the sample is

heating.

“Temp Threshold” - This field specifies an acceptable variance on the

temperature.  For example, if the temperature setpoint is 150° and the

“Temp Threshold” is set to 5°, the unit will consider the setpoint reached

when the temperature is between 145° and 155°. 

“Temp Unit” - set temperature units to either °F or °C

“Rate Unit” - set the rate units to either RPM or 1/s

“Pressure Unit” - The field is not used on the Model 900.

“Hystoresis” - If this box is checked, each sweep will be performed for-

ward and backwards.  

“Stir Parameters” - These parameters only apply if the test includes a gel

time.
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“Stir Prior to Gel” - Check this box to stir the sample before calculating

gel strength.

“Gel Stir Rate” - This is the rate the sample will be stirred prior to calculat-

ing gel strength.

“Gel Stir Time” - This is the time interval the sample will be stirred.

“Plot All Records” - If this box is checked, all records will be plotted on

the graph.  If it is not checked, only the currently highlighted record will be

plotted.

The graph below the records provides a visual representation of the current

test.  Each line represents one aspect of the test: RPM Setpoint,

Temperature Setpoint, and Temperature PV.  Refer to the key to the right of

the graph for details.

The graph features a cursor, a vertical yellow line, that can be used to view

more detailed information about the different phases of the test.  The

“Center Cursor” button moves the cursor to the center of the graph.  Click

and drag the cursor across the graph to see more detailed information.

Refer to the “Test Detail” field below the graph for more information. 
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Software
Select Analysis

Outputs

After building a test in the Test Builder, the chart at the bottom of the Main

Screen will show the various data points being calculated by the viscometer

based on the chosen Analysis Model.  This chart, however, is customizable.

You can choose which data points are displayed on the chart and which

are not.

From the “Edit” menu, choose “Select Analysis Outputs”.  By default, all

data points are selected and will appear on the chart.  To remove a data

point from the chart, simply uncheck the box next to it.
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To review test data from past tests:

1. Select “Saved Test Data” from the “File” menu.

2. The saved test data is grouped by month.  Select the folder for the year

and month of the data you are looking for and click the small + sign

next to it.  This will show you all of the data for tests run that month,

including any comments you added.

3. Select the test you are looking for and click the “OK” button.  Multiple

tests can be selected by holding down the CTRL key and selecting

each test.

4. On the “Raw Data” tab you will see the graph of the test results.  The

“Analysed Data” tab shows the results of the calculations based on the

Analysis Model.  The “Test Setup” tab shows the parameters of the test.

Software
Saved Test Data

Saved Experiment Explorer

Raw Data
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“Export” - Click this button if you wish to export the test data to a file.  You

will be asked to select a filename and destination and then click “OK”.  The

resulting file can then be opened in Microsoft® Excel for further analysis.

“Print” - Click this button to print the results to the default printer.

“Experiment Explorer” - Click this button to choose another set of test

data to review.

“OK” - Click this button to return to the main screen.

Analysed Data

Test Setup
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On the Calibration History Screen, you can retrieve the data from all past

calibration tests.

1. Begin on the Main Screen.  Select “Calibration History” from the

“Utilities” menu.

2. The calibration tests are grouped by month.  Select the folder for the

year and month of the calibration test you are looking for and click the

small + sign next to it.  This will show you all of the calibration tests run

that month, including the fluid batch and any comments you added after

the test.

3. Select the test you wish to view and click the “OK” button.

4. You can now see the graph, chart, and fluid batch details.

5. Click the “Export” button if you wish to export the calibration results to a

file.  You will be asked to select a filename and destination and then

click “OK”.

6. When you are finished reviewing the calibration history, click the “OK”

button to return to the main screen.

Software
Calibration History

Calibration History Explorer

Calibration History
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The Import/Export feature of the ORCADA™ Software makes it possible to

transfer a test from one PC to another.

1. Begin on the Main Screen.  Choose “Export” from the “File” menu.

2. Select the tests you wish to export.  Hold down the CTRL key to select

multiple tests.

3. Click the “Export” button.  You will be asked to choose a destination

and filename and then click “OK”.

4. Copy this file to the destination PC.

The file must be placed in the correct folder for it to be available for

import.  To find this folder, first navigate to the folder specified in the

“Data Archive Directory” field in the Options screen (see page 26 for

details).  From there go to the “ORCADA” folder and then the “Tests

Import Export” folder.

5. On the destination PC, choose “Import” from the “File” menu.

6. Choose the tests you wish to import.  Hold down the CTRL key to

select multiple tests.

The “Export” field lists all of the files that are available for import.  Once

you have selected one, the “Tests” field shows which individual tests

can be imported from that file.

Below the “Export” and “Tests” fields is a display-only field that shows

the folder being scanned for exported tests.  Make sure the tests you

want to import have been placed in that folder.

7. Click the “Import” button.  The new tests will appear in the list in the

upper left-hand corner of the Main Screen.

Software
Import/Export

Export Import



From the Onboard Functions screen, you can create custom test programs

to be uploaded to the Model 900 unit.  These programs can then be run

from the onboard control panel, without requiring the ORCADA™ software.

1. Begin on the Main Screen.  On the “Utilities” menu, choose, “900

Onboard Functions” then “Onboard Program Builder”.  When the screen

opens, the unit will transfer the programs stored in the unit’s memory to

the PC.  These will be displayed in the “Onboard Programs” list in the

upper left-hand corner of the screen.

2. If you are editing an existing onboard program, select the program

name from the “Onboard Programs” box and click the “>>” button.  This

will copy the steps of the selected program into the “Program Steps”

box where they can be edited.

3. At the bottom of the screen, select the desired temperature units (°F/°C).

4. Enter the required information in the “Program Steps” box.  To insert or

delete a row, click the corresponding “Program Actions” button.

a. “Temperature” - temperature setpoint

b. “Time” - time to heat the sample (mm:ss)

c. “RPM” - rotational speed

d. “CMD Char” - 

i. “a” - This option calculates the average shear stress over

the conditioning period. 

ii. “m” - This option performs a mudsweep when both the

“Temperature” and “Time” conditions are met.  During

the mudsweep, the rotor is turn at 300 RPM for 15 sec-

onds, then 600 RPM for 15 seconds, then the software

calculates plastic viscosity (PV) and yield point (YP).

e. “Gel Time” - time to let the sample stand before calculating gel

strength (mm:ss)

5. When you have finished entering all of the test steps, select a slot on

the “Onboard Programs” box and click the “<<” button.  This will copy

the steps from the “Program Steps” box to the Model 900 unit.  Each

slot in the “Onboard Programs” box corresponds to a program number

on the Model 900.  The first slot will be #1 on the unit, the second slot

will be #2, etc.

If the slot you choose is already storing a program, that program will be

overwritten by the new one.
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6. Programs can be archived to disk for backup and easy access.  The

“Archived Programs” box displays all archived programs.  These pro-

grams are accessed and modified the same as the onboard programs.

Onboard Actions:

>> - This button copies the steps of the selected onboard program into

the “Program Steps” box.

<< - This button copies the steps from the “Program Steps” box into the

selected onboard program.  The selected program will be overwrit-

ten and the new program will be copied to the Model 900 unit.

Delete - This button deletes the selected onboard program.

Archive Actions:

>> - This button copies the steps of the selected archived program into

the “Program Steps” box.

<< - This button copies the steps from the “Program Steps” box into the

selected archived program.  The selected program will be overwrit-

ten.

Delete - This button deletes the selected archive program.

Program Actions:

“Delete Row” - deletes the selected row in the “Program Steps” box

“Insert Row” - inserts a new row above and identical to the selected row

Patent No. 6,776,028 - OFI Testing Equipment, Inc.
OFITE, 11302 Steeplecrest Dr., Houston, TX 77065 USA / Tel: 713-880-9885 / Fax: 713-880-9886 / www.ofite.com 37



1. To transfer the results of the last test from the Model 900 unit to the PC,

click “Utilities”, then “900 Onboard Functions”, then “Upload Test Data”.  

2. Click the “Upload” button to initiate the transfer and display the data on

the screen.  Each line shows one step of the test.

a. “Temp SP” - temperature setpoint

b. “Time” - elapsed time (in minutes) for the step

c. “Cmd Char” - command character

d. “Gel Time” - gel time set point

e. “Temp PV” - temperature process variable.  This is the actual tem-

perature of the sample

f. “S.S.” - shear stress

g. “Gel S.S.” - gel shear stress

h. “300 RPM DR” - If the “Cmd Char” is “m”, this will show the 300

RPM dial reading.

i. “600 RPM DR” - If the “Cmd Char” is “m”, this will show the 600

RPM dial reading.

j. “PV DR” - If the “Cmd Char” is “m”, this will show the plastic viscos-

ity dial reading.

k. “YP” - If the “Cmd Char” is “m”, this will show the yield point dial

reading.

l. “User S.S.” - If the “Cmd Char” is “a”, this will read the average

shear stress.

m. “RPM” - rotational speed (RPM)

n. “Shear Rate” - rotational speed (1/s) 

o. “Viscosity” - average viscosity

3. Click the “Export” button to export the data to a disk file.

4. Click the “Save To Disk” button to save the data to the “Upload Data

Explorer” to be viewed later.

5. Click the “Upload Data Explorer” to access previously saved data sets.
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a. Locate the folder for the date of the saved data.

b. Click the small + sign next to the folder.

c. Select the data set you wish to view and click “OK”.

d. The data set will appear on the screen.

6. Press the “OK” button to close the “Upload Test Data” and return to the

main screen.
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This procedure should be performed immediately after every test and cali-

bration.

1. Turn the unit off.

2. Remove the R1 rotor from the drive rotor.

3. Place bobshaft wrench on the flats located just above the bob.  Remove bob. 

Do not try to remove the bob without the wrench.  Doing so can

cause severe internal damage.

4. Once the bob is removed, remove splash guard and wipe down the bob-

shaft.  Clean all removed parts with water and or appropriate solvent.

The Model 900 utilizes a stepper motor / timing chain, drive and a non-con-

tact rotational transducer detection system, which is extremely accurate

and sensitive enough to detect micro-divisions of 1/262,000th of a revolu-

tion.  This viscometer utilizes an absolute minimum of moving parts, and

there are no gears to jam up or get worn down like more conventional

units.  The bob shaft bearings are isolated from the rotation of the rotor,

which ensures no induced drag on the bob shaft due to rotation.  This

results in more sensitive and accurate readings, particularly at low shear

rates, and the life of the bearings is prolonged.  When replacement is war-

ranted however, the bearings and the torsion spring may be easily

changed.  This is a major advantage over previous viscometers.

It is important to remove the bob from the bob shaft during viscome-

ter transport to prevent bending or damaging the bob shaft assembly.

Tools Required:

Allen Wrench, 1/16"

Allen Wrench, 5/64"

Allen Wrench, (1.5 mm provided)

Split Ring Pliers, small

Bob Shaft Wrench (provided)

Bob Shaft Bearing Replacement:

1. Unplug all electrical wires and the thermocouple wire from the housing.

Ensure bob and rotor have been removed.  Remove the five screws

along the base of the outer housing cover, and gently lift off the cover.

Warning: Risk of electrical shock.

2.   Unplug the torque transducer cable from the inner housing cover.

3. Remove the main housing cover by unscrewing the three Allen screws.   

4.   Carefully lift the entire assembly out of the main housing. 
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5.  Using the split ring pliers, carefully remove the two split rings from the

lower bob shaft bearing.

6.  Remove the four Allen screws from the underside of the main housing

cover.

7. Gently slide the bob shaft housing down the bob shaft, to access the

upper bob shaft bearing.  Unlike the lower bearing, this one readily

comes off of the shaft, with no retainer ring holding it in place.

8. Replace the upper bearing first and re-attach the bob shaft housing to

the main housing cover with the four Allen set screws.

9.   Slide the lower bearing into place and secure with new retainer rings.

10. Replace main housing cover onto the main housing with the three

screws.  Be sure the serial number is facing forward on the transducer.

11. Re-attach the torque transducer cable to card.

12. Replace the outer housing cover.  Take care that no cables are pinched

between the cover and the frame.
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Main Shaft Bearing Replacement:

1. Unplug all electrical wires and the thermocouple wire from the housing.

Remove the Allen screws along the base of the outer housing cover,

and gently lift off the cover.

2. Unplug the torque transducer cable from the inner housing cover.

3. Remove the main housing cover by unscrewing the three 5/64" Allen

set screws.   

4. Carefully lift the entire bob shaft assembly out of the main housing.

5. Loosen the motor with the appropriate Allen wrench.  The four screws

are located around the base of the motor. 
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6. Gently slide the motor forward to loosen the chain, freeing it from the

sprocket. 

7. Remove the split ring from on top of the main shaft bearing.  A small flat

head screwdriver may be used for removal. 

8. Slide the main shaft assembly down out of the main housing body.  The

upper bearing will stay inside the housing, but it can be easily removed

and replaced by lifting it up out of its recess. 

9. To replace the lower main shaft bearing, loosen the two Allen set

screws on the side of the sprocket.  The sprocket and the bearing may

then be removed from the main shaft.

10. Replace the lower bearing and sprocket, tighten the Allen screws, and

replace the assembly inside the main housing.  Make sure the belt fits

around the teeth in the sprocket.

11. Replace the split ring on top of the main shaft bearing.  It is easier to

replace the split ring if upward pressure is applied to the main shaft

assembly from below.  

12. Again make sure the belt fits around the sprocket teeth, and then push

the motor toward the back of the viscometer.  This will tighten the belt.

Turn the main shaft by hand to make sure the belt and main shaft

assembly are turning freely.  Tighten down motor.

13. Re-attach the main housing cover and re-calibrate.

Torsion Spring Replacement:

1. Unplug all electrical wires and the thermocouple wire from the housing.

Remove the Allen screws along the base of the outer housing cover,

and gently lift off the cover.

2. Using the Allen wrench, loosen the recessed set screw in the side of

the Zero Calibration Knob.

3. Using the metric Allen wrench (provided) carefully loosen the Allen set

screw in the transducer clamp located on top of the transducer.    

It is very important that no downward pressure is applied to the

transducer spring clamp at this time.

4. The torsion spring can now be removed from the top.    
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5. The replacement spring must be carefully placed inside the transducer

clamp so that it seats all the way down.  The bottom lock collet should

be enclosed and the upper collet should be inside the spring clamp of

the zero calibration knob.

6. Carefully tighten the spring clamp set screw on the transducer with the

metric Allen wrench.  

7. Tighten the 1/16" recessed Allen set screw on the side of the Zero

Calibration Knob.

8. Loosen the two 5/64" Allen set screws that hold the Zero Calibration

Knob in place.

9. Turn on the Viscometer, and press the calibration button on the lid of

the housing.  Adjust (turn) the Zero Calibration Knob until the “P” num-

ber falls with the given range (between 15,000 and 25,000).  

10. Tighten the two 5/64" Allen screws on the side of the Zero Calibration 

Knob.

11. Replace the outer housing cover.

12. Re-calibrate.
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Appendix
Thermocouple

Calibration

In order to calibrate the thermocouple properly, the temperature units on

the viscometer must be set to Celsius.  If the unit is set to Fahrenheit,

change it to Celsius before calibrating:

1. Press SET UP

2. Press NEXT 6 times.  The displays should now read “Temperature

Units:”

3. Enter 1

4. Press ENTER, then CLEAR/STOP to return to the main screen.

To calibrate the thermocouple, compare the temperature reading of the

thermocouple to that of an NIST traceable thermometer.  Then set the tem-

perature offset on the Model 900.

1. Press SET UP.

2. Press 600 3 times.

3. Press NEXT 11 times.  The display should now read “TC Offset”.

4. Enter 0

5. Press ENTER, then CLEAR/STOP to return to the main screen.

6. Record the temperature readings of both the NIST traceable ther-

mometer and the Model 900 Viscometer.

Example: NIST traceable thermometer reading:  21.0°C

Model 900 Viscometer:  23.2°C

Temperature Differential:  -2.2°C

7. Repeat steps 1 through 3 above to return to the thermocouple offset

screen.

8. Enter 2.2.  The extra “.” specifies a negative value.

9. Press ENTER, then CLEAR/STOP to return to the main screen.

10. The unit should display the same temperature (± 0.2°C) as the

NIST traceable thermometer.
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Appendix
Grounding

Proper grounding protects the equipment operator from the risk of electric

shock. The electrical cord provided with this equipment has an equipment-

grounding conductor and a grounding plug. Observe the following guide-

lines at all times:

- Always connect the plug to a matching outlet that is properly installed

and grounded.

- If an extension cord is necessary, make sure it has three prongs and is

compatible with the electrical cord provided with the equipment.

- Do not modify the electrical cord provided with the equipment. If it is not

compatible with any available outlets, have a compatible outlet installed

by a qualified electrician.

- If the equipment-grounding conductor (solid green or green and yellow)

is improperly connected, the operator will be at risk of electrical shock.

Never connect it to a live terminal.

- Local codes may require a Ground Fault Interrupt Circuit (GFIC).

- Repair or replace a damaged or worn cord immediately.

- When in doubt, consult a qualified electrician.
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Appendix
Technical Support

For support, contact the OFITE Technical Services Department:

Phone: 713-880-9885

877-837-8683

Fax: 713-880-9886

Email: TechService@ofite.com

Mailing Address:

11302 Steeplecrest Dr.

Houston, Texas 77065
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